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Introduction

This document provides a quick overview of new features in BioWin 6.0

Model Additions Usability Upgrades
e Chemical Phosphorus Removal e Drawing Tools / Undo
e Sulfur (Biological, RedOx, etc.) e Excel Reporting
e Industrial Organics e Variable Naming / Sorting
e CEPT e Element Tags
e |ron RedOx e Table Transposition
e P Recovery (Brushite, Vivianite) e Optional Alarms
e Cellulose e More Example Flowsheet
e Source Separated Organics Templates

e Set All Parameters Default

e Metal Salt Sol’n Densities

e m?3/hr Flow Units Option

e Wet Tonne Sludge Cost Option

The BioWin Manual is provided in two forms:

e As a PDF (default install location is C:\Program
Files(x86)\EnviroSim\BioWin 6.0\Manuals)
e In“Windows Help” format from within BioWin

To Use PDF
e Open it from directory above

e Or copy it to any other location of your choice (e.g. Desktop, My
Documents)

To Use Windows Help
o Select Help > Contents & Index

e Click Help button
e Press F1 key on your keyboard (context-sensitive method; will open a
relevant topic in the manual)
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Example Manual reference:

For more details on topics, references to relevant sections of the BioWin Help

Manual are provided

& BioWin Help Manual - m} x
. eI
Hide  Back  Pant  Options
Model Reference = Chemical Precipitation Reaction o

Contents | index | Search | Favories |

] Fome Fage Chemical Phosphorus Removal with Iron Salts

@ Welcome to BioWin

@ Help. Tutorials and Examples
@ Gereral Operation The following figure illustrates the processes involved in chemical phosphorus removal with iron salts.
@ Building Configurations

@ Running Simulations

@ Data Output (charts, tables, reports)
= () Model Reference ——* Precipitation
@ Biological/Chemical Modsls Aging

= ([ Chemical Precipitation Reactions —— Adsorption

b Scherical Phosphonus Hemoval wih fon Sats) - Co-precipation
@ Chemical Phosphorus Removal with Aluminum Salts Ovidation

[7] Setting up Channels

Chenmical Phosphorus Removal Example
Modeling Metal Colloidal Coagulation Reactions
@ Iron RedOx Reactions and Precipitation of Vivianite and Fe|
@ Precipitation of Brushite, Hydroxy-Apatite and Struvite
@ Wodeling of pH and Alkalinity

@ Modeling of Industrial Components

@ feration and Gas Transfer Model
@ Solid-Liquid Separation  Clarfier Models
@ Modeiing Fixed Film Processes
Modeling Sidestream Treatment Processes . !
g Modeling Granular Sludge Sequencing Tanks Fe” HFO - Low Surface HFO - Aged
Defintion of Non-State Variables T (P Bound on Aged HMO)
@ COD and BOD in BioWin H,PO," g |§ W H,PO;
@ Powerin BioWin 1T st
@ Operating Costs in BioWin o
[7] Glossary of Terms

HFO - High Surface + H" HFO - Low Surface + H*

HFO - High Surface + H,PO, HFO - Low Surface + H,PO,
Schematic representation of the ferric precipitation model in BioWin

When the model option Include ferric — phosphate adsorption/precipitation reactions is selected addition of
ferric to water results in the rapid precipitation of hydrous ferric oxides (HFO) with a high number of active surface
sites, HFO - High surface. When the model options Include ferric - phosphate adsorption/precipitation
reactions AND Include iron reduction/oxidation reactions are selected, addition of ferrous to an oxidizing
environment can result in the oxidation of ferrous to HFO — High surface. HFO - High surface will either age to
HFO - Low surface or adsorb/co-precipitate with H,PO,", H™, or colloidal COD (Xsc). The fate of HFO - High
surface depends on the mixing intensity, the pH, and whether the model option Include metal salt - colloidal
material coagulation reactions is selected. (See_Factors Impacting HFQ Interactions).

< >
Depending on the pH, H,PO,” can co-precipitate with HMO - High surface to form HFO - High surface with H,PO,".

MODEL REFERENCE :

Chemical Precipitation Reactions > Chemical Phosphorus Removal with Iron Salts
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Model Addition — Sulfur

Extension of what has been in PetWin for several years

Reduction N,
Stripping H,S0,
>e> Precipitation D0>0.25 zg:gdqf
AEROBIC Sulfur H,CO4 002025 ANOXIC
DO<0.25
D0>0.05 NO;
Stripping H,S.
Ac,Hy
Ao ANAEROBIC
CO,;
Pr
2
H,SO,
FeS
/k i
H,S Sulfur
HFO(H, L. HP, LP,0)

Sulfide-oxidizing bacteria

Sulfate-reducing bacteria (multiple types)
Potential hydrogen sulfide stripping
Iron-sulfide (FeS) precipitation

Model iron addition for H,S
control

Simplified Sulfur Process

Oxidation

Model Reference > Biological/Chemical Models > Sulfur Modeling
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Model Addition — Industrial Organics
Based on original Alison Baker PhD (~1994, McMaster)

e Four new state variables for industrial components

» Mixed removal pathways — stripping and/or biodegradation

o Default settings for industrial components mimic xylene, phenol, benzene,
and toluene

e Biodegradation according to inhibitory Haldane kinetics

Monod and Haldane Equations

[ [—Monod
[ Haldane (Kl = 1000 mg/L)
9 [ —Haldane (KI = 100 mgiL) S

— B H = Unax "
4 y— K+ S + f{,—z
LA ‘ ‘
NV

0 10 20 30 40 50

Concentration, mg/L

Growth Rate
(%]

MANUAL REFERENCE :

Model Reference > Modeling of Industrial Components
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Model Addition — Chemical Phosphorus

New P removal mechanisms (hydrated metal oxides)

e Based on EnviroSim-sponsored research
e Extensive calibration for wastewater systems
e Overcomes weaknesses of old “WEF model” (e.g. fixed Me:P

stoichiometry)
e Can have simultaneous ferric / ferrous / alum inputs

Precipitation
Aging
—— Adsorption

Co-precipitation
Xsc

. X
/—7\""SP
f(G) f(G)

AP* HAO - High Surface HAO - Low Surface HAO - Aged
(P Bound on Aged HMO)
H,PO,’ H.PO,

=
I

(Hd) }

HAO - High Surface + H,PO, HAQO - Low Surface + H,PO,

MANUAL REFERENCE :

Model Reference > Chemical Precipitation Reactions > Chemical Phosphorus

Removal with Aluminum Salts
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Model Addition — Chemical Phosphorus
Updated P removal mechanisms (hydrated metal oxides)

——— Precipitation
Aging

——— Adsorption
Co-precipitation

— Oxidation
Fe2*
0 .,
i Xsc
J e X
S T T e w P
2
H
0y
o ) f(G) f(G)
Fe” ————————» HFO - High Surface HFO - Low Surface HFO - Aged
(P Bound on Aged HMO)
E R LT R
HFO - High Surface + H HFO - Low Surface + H'
HFO - Low Surface + H,PO,

HFO - High Surface + H,PO,

MANUAL REFERENCE :
Model Reference > Chemical Precipitation Reactions > Chemical Phosphorus

Removal with Iron Salts
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Model Addition — CEPT

Option to model colloidal COD / metal interactions

e Model can convert non-settleable colloidal COD to settleable particulate
COD in the presence of hydrated metal oxides (HMO)

e Process will also reduce potential adsorption of P on HMO

e Ideal or model clarifier can then be used to mimic increased solids and
BOD removal

Precipitation
Aging
—— Adsorption

Xs_c
_____ -
a4+ i f(G) f(G)
Al HAO - High Surface HAO - Low Surface HAO - Aged

Precipitation

Aging
——» Adsorption

Xs_c
_____ -
f(G) f(G)
Fe® HFO - High Surface HFO - Low Surface HFO - Aged

MANUAL REFERENCE :

Model Reference > Chemical Precipitation Reactions > Modeling Metal-Colloidal
Coagulation Reactions
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Model Addition — Iron RedOx

Option to model iron oxidation / reduction reactions

e New ferrous input (as either ferrous chloride or ferrous sulfate)

e Ferrous oxidized to ferric in aerobic environments

e Ferric reduced to ferrous in anaerobic environments

e Option to track iron-based precipitates {i.e. FeS and vivianite [Fe3(PO4):]}

Precipitation
———— Reduction

— Oxidation g SeC0us Sbsa, Sbsp, Hy, H,S
FeS PLn.,

HFO (High Surface, Low Surface, High with P, Low with P, Aged)

Fa?* ——— > HFO - High Surface
Fe;(PO,), o . i .
Vivianite S 1
0, H,0
MANUAL REFERENCE :

Model Reference > Chemical Precipitation Reactions > Iron RedOx Reactions and
Precipitation of Vivianite and FeS
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Model Addition — Options for P Recovery

Improved tracking of Ca** and Mg**

¢ Previously Ca?* and Mg?* only available throughout the flowsheet via input
of soluble influent concentrations

e Underestimated the amounts entering digesters via solids streams limiting
the amounts of potential precipitates

« Model updated to include Ca** and Mg?* in biomass (taken up as part of
“synthesis I1SS”) and influent degradable solids (Xsp)

Additional sinks for P

e Vivianite formation

e Struvite formation as in previous versions of BioWin but no longer Mg**
limited!

e Calcium phosphate precipitate (as Brushite)

e Lowers return stream soluble PO4 to levels typically observed

MANUAL REFERENCE :

Model Reference > Chemical Precipitation Reactions > Precipitation of Brushite,
Hydroxy-Apatite and Struvite
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Model Addition — Cellulose

Cellulose tracking

e Influent unbiodegradable particulate material split into two components:
cellulose and non-cellulose

e Separate COD:VSS ratios for each

e Helps to fine-tune sludge production and digester performance

e Enables modelling of cellulose recovery

MANUAL REFERENCES :

1. Model Reference > Biological/Chemical Models > Activated Sludge
Processes > Growth and Decay of Ordinary Heterotrophic Biomass >
Stoichiometric Parameters

2. Model Reference > Definition of Non-State Variables

Model Addition — Cellulose | 12




Model Addition — SSO

New input for SSO

e State variable (CODp-Xeo) for adding particulate degradable COD (e.g.
Source Separated Organics)

e Has specific COD:VSS; added as a separate input to avoid conflicts with
municipal wastewater characteristics

e Optiontoinclude N and P

e Constant or time-varying, as with any BioWin input

PS5 Holding Tank Digester
P>l
Cake
550

=

MANUAL REFERENCES :

1. Model Reference > Biological/Chemical Models > Hydrolysis, Biological
adsorption, Ammonification and Assimilative denitrification
2. Model Reference > Definition of Non-State Variables

13 | Model Addition — SSO




Usability Upgrade — Drawing Toolbar

e UNDO button!! Use for accidental element deletion, moving, etc.
e Buttons for copying pipe format from one pipe to others
e Buttons for aligning flowsheet elements (vertical or horizontal q

centers)
e Buttons for spacing flowsheet elements evenly (vertically or w

horizontally) - ""
e Buttons for flipping flowsheet element images (horizontally or

vertically) " o
e Button for copying selected element(s) " .

MANUAL REFERENCE :

General Operation > Main Simulator Window > Toolbars > Flowsheet T ﬂ

Tools ﬂ

3
gt

L
ﬁ
hd ]
+ B
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Usability Upgrade — Report to Excel

e Automatic rapid generation and export of data, charts, etc. to Excel

o Ideal for generating Mass Balance tables to use in PFDs

e Preconfigured templates are customizable

e Canincorporate “post-BioWin” calculations (e.g. MLVSS/MLSS, COD/BOD)
using Excel formulas

e Option for including both steady state and dynamic simulation databases

e Caninclude BioWin charts — these are converted to Excel charts with data

e Report to Word still available BloWin Tankage Summary

BioWin Mass Balance Summary Volume Units: m3
NRCY

Reactors Name Volume

Aerobic 40,000.0

Anoxic 10,000.0

Group Total 50,000.0

Secondary Clarifiers Name Volume

— Clarifier 20,0000

Group Total 20,000.0

Total Volume for All Units 70,000.0

Wass Rate
g 8 8 2 2 z 3 I 3
@ S 2 2 2 E z 2 £
Pipe Name m3d kgld kgid kgld kgid kgid kgid kgid kgid kgld
F01 100,000.0 50,000 24521 2221 19771 4,000 2640 [) 650 325
F.02 4975680 2066615 606634 1752410 1413482 110671 3325 86 35265 1491
F03 4975880 2044829 592708 1742104 1402482 107,991 516 2314 35,265 1545
F-04 1075880 811,984 235359 691,775 556,918 42882 208 919 14,003 613
F.o5 97,5880 3652 416 891 77 291 101 454 320 303
F-06 1000000 808332 234,943 690,884 556201 42591 104 465 13683 310
o7 1000000 808332 234343 690,884 556,201 42,591 104 465 13,683 310
F.08 97,5680 788835 229278 674220 542785 41,564 101 ase 13383 303
F-09 24120 19,497 5667 16,664 13416 1027 2 1 330 7
F-10 24120 19,497 5667 16,664 13416 1,027 2 11 330 7
F11 3000000 1232845 357349 1050320 845575 65,109 ant 1395 21.262 931
F12 3000000 1232845 357349 1050329 BASS7S 65,109 3t 1395 21262 931
BioWin Reactor Summary
Allairflows reported at 20 deg C and 1 atm
Bioreactor
9 ] §
2 < =
¢ 8 g 9 B 2
z b
8 E 2 2 z |3 ¥ o w o ] B 3 % % % % g ES
E x
e &z £ E s 8§ & & & 3 & 2 £ ¢ ¢ ¢ i B i
Tank Nam m2 m m3 # m3fhr (20€, 1 atm) mgil kghr % kghr % mglbr___ mglL mglL mglL mglL mglL mgll mgil = kg =
[Anoxic 2222 750 10,0000 0 O 00 0 000 0 000 00 3522 2841 57 00 02 02 30 599 EFI
[Aerobic 8889 450 400000 21680 49,202 20 4195 305 1303 104 338 3501 2819 10 03 43 47 a1 6.86 140044 BOS%
Average 49,292 20 4195 305 7 1393 104 338 3511 2630 39 02 22 24 a1 806%
Total 1411 500000 21680 49,202 4,195 1,383 175262

MANUAL REFERENCE :

Data Output (charts, tables, reports) > Creating Project Reports > Creating an
Excel Report
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Usability Upgrade — Variable Naming & Sorting

e Variables and parameters renamed for improved consistency
e Allows for simpler alphabetical sorting

E' - E'ar_ticula_te undeg_radgb_\e_[mg_F’_{‘I:]

B BioWin Explorer - Click in left panel to refresh right panel — m} X
View
(- Elements State varisble | value [ Mass rate (kg/d) | Notes | ~
E1- Bioreactar Biomass - Acetoclastic methanogenic [mgCODAL] [IN}] 12.80 m—
- Aerabic #1 Biomass - Ammonia oxidizing [mgCOD/L] 41.75 5010.07
Biomass - Anaerobic ammonia oxidizing [maCOD /L] 037 44,93
- herobic #2 Biomass - Endogenous products [mgCOD L] 54355 ER941.58
. bverobic 13 Biomass - Hydragenotrophic methanagenic [mgCODAL] 0.0z 212
. Biomasz - Methylatrophic [mgCODAL] 40,99 4918.65
Aerotic e Biomass - Mitrte wxidizing [mgCOD/L] 2372 264572
Anoic 1 Biomass - Ordinany heteratroptic [moC0D /L] 17010 14040304
- Anoxic #2 Eiomass - Phosphorus accumulating [maC0D0 L] 0.34 1.1
[ Denitritation Biomass - Propionic acetogenic [maC0D /L] 0.09 10.76
B- Bioreactor - Sidestream Biomass - Sulfur oxidizing [maCOD/L] 3264 3917.06
- Clarifier - Model Biomass - Sulfur reducing acetolrophic [mgCOD L] 0.34 41.35
L R . Biomass - Sulfur reducing hydrogenatrophic [mgCOD /L] 8.88 1065.23
- Digester - Anzerobic Biomasz - Sulfur reducing propionic acetogenic [maCOD /L] 037 4483 —
G- Effluent CODp - Adsarbed hydrocarbon [mgCODAL] 000 000
Bl Equalization Tark CODp - Degradable extemal arganics [maCoD /L] 0.00 0.00
- Irfluent - COD CODp - Slowly degradable collaidal [mgCOD AL 0.41 4860
B Influent - State variable CODp - Slovly degradable particulate [magC0D /L] g6.02 10321.72 -
B Input - FOG CODp - Stored PHA [maCOD L] 0.00 055
- Irput - Metharol CODp - Undegradable cellulose [mgCODAL] 30213 3E252.68
- Miser - General CODp - Undegradable non-cellulose [mgCODAL] 0213 J6252.68 g
CODs - Acetate [maCOD L] n.0z 2.46
-Pump CODs - Complex readiy degradable [maCOD/L] 143 17118
Bl Separator - Diewatering unit CODs - Degradable volatils ind. #1 [mgCODAL] il il
- Settler - Ideal primary CODs - Degradable volatile ind. #2 [maCOD /L] 1] 1]
[ Sludge CODs - Degradable volatle ind. #3 [mgCOD /L] 1] 1] —
BT Spliter CODs - Methanol [maCOD/L] 0.on 0.on
CODs - Propionate [maCODAL] 0.00 0.3
CODs - Soluble hypdiocarbon [mgCOD/L] 1] 1]
CODs - Undegradable [mgCOD /L) 28.00 3360.10 —
Gas - Diszalved hydrogen [mgCODAL] 0.03 3.06
Gas - Dissolved methane [mgrL] 0.00 0.m
Gas - Dizzalved rittogen [mah /L] 17.23 2067.80
Gas - Dizzalved rittous oxide [mghl L] 1] 1]
Gas - Dissolved oxpgen [mgdl] 2.00 23998
Gas - Dissolved total COZ2 [mmal L] 5.50 E53.7E mmol/L and kmalid
Gas - Diszalved total sulfides [mgS /L] 0.54 E4.33
HAD - Aged [morL] il il
HAD - High surface [mg/L] 1] 1]
HAD - High with H2PO4- adsorbed [mgdL] 1] 1]
HA0 - Low surface [magrL] o o
HAD - Low with H2PD 4- adzorbed [ma/L] 1] 1]
HFO - Aged [ma/L] 0 0
HFO - High surface [mgrL] 1] 1]
HFO - High with H+ adsorbed [magL] 1] 1]
HFO - High with H2PO4- adsarbed [mgrL] o o
HFO - Law surface [masL] 1] 1]
HFO - Lo with H+ adsorbed [mg/L] 0 0
HFO - Laws with H2P04- adsorbed [mg/L] o o
Influent inorganic suspended solids [mgl55/L] 355.64 42673.96
tetal soluble - Aluminum [mg/L] 1] 1]
Metal soluble - Caleium [mg/L] 169.54 20344.05
Metal soluble - Femic [masL] 1] 1]
tetal soluble - Fermous [mg/L] 1] 1]
Metal soluble - Magnesium [ma/L] 2472 2966.34
M - Ammonia [mghl /L] 274 328.76
N - Mitrate [mgh /L] 2.04 24423
N - Nitrite [rgh L] 077 9260
M - Particulate degradable external organics [mah/L] 1] 1]
N - Particulate degradable organic [mgh/L] 35 421.64
N - Particulate undegradable [mah /L] 10.57 1268.84
M - Soluble degradable organic [mgh /L] 0.45 R4.60
N - Soluble undegradable arganic [mgh /L] 0.80 96.03
QOther Anions [strong acids) [meq/L] 10.20 122399 meq/L and kegd
Other Cations [strong bazes) [megyL] 497 B9E.77 meg/L and keg/d
P - Bound on aged HMO [maP/L] 1] 1]
P - Particulate degradable extemnal arganics [mgP /L] 1] 1]
P - Particulate degradable organic [mgP/L] 1.23 148.18
332 398.78 v

MANUAL REFERENCE :

Model Reference > Definition of Non-State Variables
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Usability Upgrade — Flowsheet Tags

Customizable element-specific information

e Information updates with simulations
e Can contain state, combined, and element-specific variables

NRCY
TSS (U) [mg/L] | 8.508.24
-+ Q <f Flow (U} [m3/d] | 100.000.00
% TSS Rem. [%] |22.87
SIR [kyim2 )] | 128.35
Influent Anoxic Aerobic SOR [m3/(ma2 4 15.52 Effluent
N - NH3 [mghiL] |e8e N - NH3 [mghiL] | 1.04
N-NOx [mghiL] |o.17 CBOD - T [mgiL]|4.28
P- P04 [mgPiL]|2.00 N -NOx [mghiL] | 485
TSS [mgil] | 2.821.83 N-TN [mghiL] | 7.4
P-PO4 [mgPiL]|z.10
P-TF [mgPiL]|2.28
RAS Pump 788 [mgi]|a.12
' ——
WAS Pump WAS

————t
- F
Flow [m3/d] | 2.412.02

CBOD-T [kg /d] | 5.868.88

COD-T [kg /d] | 19.457.14
N-TKN-T [kg Nid] | 1.027.30
P-TP [kg Pid] | 230.04

TSS [kg /d] | 18.684.28

VSS [kg /d] | 13.415.69

MANUAL REFERENCES :

1. General Operation > Customizing BioWin > Customizing the Project
Appearance > Drawing Board

2. General Operation > Customizing BioWin > Customizing the Work
Environment > Default tags

3. General Operation > Managing BioWin Projects > Setting Project Options >
Drawing Board Options

17 | Usability Upgrade — Flowsheet Tags




e Can control location (above, below elements)
e Canreplace flowsheet icons if desired

Influent
NRCY
Flow [ma/d] | 100000 00
CBOD - T [mgL]|230.43 Flow [maia] | 20000000
COD-T [mg/L]| 500.00 Fiow (m3/q | 30000000 [] Fower [kW] | 6149
N-TKN-T [mghaL]| 40.00 CBOD - T [kg /d] | 34349521 | | PE! (kwW-herML m] | 3.21
P-TP [mgPiL]|6.50 COD-T [kg id] | 1200745 86
TSS [mgiL]| 22441 N-TKN-T [kg Nid) | 72664 40
VSS [mg/Lj| 199.41 P-TP [kg Pid] | 2684577
Flow [ma/a) | 100000.00— Tss [kg i) | 1005243 30
CBOD - T [kg id] | 23943.17 VSS [kg id] | 67182627

COD-T [kg id] | 50000.12

Usability Upgrade — Flowsheet Tags | 18

N-TKN-T [kg Nid] | 4000 30
P-TP [kg Pid] | 65020 R Aerobic Effluent
78S [kg /d] | 22441 05 Anoxic N - k3 [mgni]| 136
VSS [kg /d]| 1994105 R N-NO2 [mghiL] |0 40 TSS (U} [mgiL] ] 7205.23 . N - NH3 [mgNAL]| 1.36
N-nox [mgna)| 010 N - o3 [mghi]| 301 Flow (U) [m3/d] Fiow [m3/a] | 9758798 CBoD - T [mgn)] 484
G-Do (mgaj| 200 % TSS Rem. [%] | 90.88 CBOD-T [k /d] | 47222 N -NOx [mghiL]| 4.30
FERED ST 2 vss (man)| 2006.00 SLR [kgimz a)] | 144 27 COD-T [kg/d] | 3767.88 N-TN [mgna] | 761
TSS mohLf 3660.35 153 [mgi ]| 3650 81 SOR [m3/(m2 d)] 19.52 N-TKN-T [kg Nid] | 322.12 P-PO4 [mgPL]{214
P-Poa [mgpnj|214 P-TP [kg Pid) | 220 25 P-TP [mgPL]| 235
TSS [kg /0] | 83318 TSS [mgiL]| 854
RAS Pump vss (kg /o] | 663 22
Fiow [m3/d] | 10000000
Fiow [m3iq] | 97587 98 Power [kW] | 1565
CBOD-T [k id] | 220317 41 PEI [kW-hriML m)] | 3 21
COD-T [kg id] | 825037 49
N-TKN-T (kg Nid] | 46300.05
P-TP [kg Prd]| 1703113 WAS Pump WAS
183 [kg /d] | 703144 02| Flow [masd] | 2412 02 N-TKN-T [mghiL) | 475.37
VSS [kg /d] | 559710 73| Power [kW]j020 [ Flow [m3id] | 241202 [ P-TP [mgPiL)| 174.52
PEI [wW-nriML m)) | 3.21 CBOD-T [kg id] | 5445.45 88 [mgiL| 720523
COD-T [kg id] | 20414.18 VSS [mgiL]| 5735 45
N-TKN-T [kg Nid] | 1146.50
P-TP [kg Pid] | 42095
Tss [kg /)| 17379.17
VSS [kg /d]| 13834.02




Usability Upgrade — Integrated Influent Specifier

- BioWin Simulator - Untitled.bwe

File Edit Tools Project View Simulate Help

DB &S SEEHB & v E 0|2

== Influent Specifier - Untitled.ets
File Setting View Stoichiometry About

Z m =m @ B A &=

Input Measurements Adjust Fractions View Results Export to BioWin
Table View
Raw {Unﬁltered) c rl Homogenize " COD - Total [mgCOD/L] 500.0
BOD - Total [ngBOD/L) 245.2
N - TKN [mgN/L 400
P - Total P [mgP/L] 65
I 5 - Total 5 [mg5/L] 15.0
Glass-Fiber Filter lkalinity [mgCaCO3/L] 3000
(1.2 um) R TSS [mgTss/L] 2427
LILLLE VSS [[mgWSSAL]) 197.7

COD - Filtersd [mgCOD/L] 1849 Coagulate / Flocculate

CODs - Acetate [mgCOD/L] 12.0

BOD - Filtered [mgBOD/L] 1025

N - Ammania [mgN/L] 26.4

M - Nitrate [mghL] 00 Membrane Filter (0.45 um)
P - Soluble phosphate [mgP/L] 3.3 i 1

COD - FF [mgCoD/L] 105.0
Other Measurements:
Flow 0.0 Gas - DO [mgO2/1] 0.0 Effluent COD - Filtered [mgCOD/L] 250
pH 73 Metal - Calcium [mg/L] 80.0 Metal - Magnesium [mg/L] 15.0
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B BioWin Simulator - Untitled.bwe

File Edit Tools Project Wiew Simulate Help

O B By B| & |v & 0|2 &3~

- Compenents of Influent - O

Influent Components (COD, N, P and ISS content) - Select tabs at lower left

€OD - Total
Measured  Calculated
500.0000 eI k1 for CODe - Xsc: 0.5000 1
BODS
k2 for CODp - Xsp:  |0.5000 1
fcBODS (GFO)
Biomass Degradable Undegradable
Fbio. = |0.0212 1
Conc= 106000 | macOD/L — mgcoDiL
Readily degradable Slowly degradable CODs - Undegradable CODp - Undegradable
Fup = [0.1300

mgCOD/L mgCOD/L Conc =

degradable dable colloidal

cellulose CODp - Undegradable non-cellulose

5000

Fnoncel =

mgCOD/L Conc =

mgCOD/L mgCOD/L mgCOD/L mgCOD/L

Close

Tabs to view COD, N, P speciation
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Usability Upgrade — Transpose Tables

Elements | COD - Total BOD - Total Carbonaceous Total suspended solids Volatile suspended solids M - Total Kjeldahl Mitrogen [kg N, M -Total N P - Soluble PO4-P [kg P, P -Total P
Infiuent 50,000.12 24,520.56 22,271.22 19,771.22 4,000,30 4,000.30 325.10 650,20
Anoxic 2,066,615.31 606,633.78 1,752,419.23 1,413,482.37 110,671.03 110,756.71 1,491.33 35,265.05
Aerabic 2,044,828.86 592,708.01 1,742,104.19 1,402,492.50 107,991.14 110,305.17 1,544.55 35,265.05
Effiuent 3,652.17 416.10 890.51 716.91 291.45 745.29 302.92 320.16
WAS 19,497.14 5,666.88 16,664.28 13,415.69 1,027.30 1,038.52 7.43 330.04
E, Edittable e
Table editor
Variables
Combined State variables Selected variables
Alk ~ |B-Zaao ~ coD-T
CBOD -5 B - Zam CBOD -T
CBOD -T B - Zao TS5
CoD-P B-Ze V55
CoD -5 B-Zh MN-TKN-T '
CcoD-T B - Zhm MN-TH
COD - VFA B -Zm P-PO4
155cel B-Zno > le-e +
ISSprec B -Zpa
IS5tot B - Zppa
M-Al-T B -Zso
M-Fe-T B - Zsra
M - NOx ¥ |B-Zzrh v [~ Duplicates
Element specific Water chemistry
--- 1. Diffused aeration --- ~  |Ac- ~
# of diffusers Al3+
Air flow rate Co3=
Air flow rate [ diffuser fd )
--- 2. Reactors and digesters ---- Fe2+ Add blank line |
Actual DO sat. conc. Fe3+
Alpha v |fm Y Add total so far |
Show
Elements Selected elements
[EI-Elements Influent " Concentrations
Bioreactor Q”"""; -
I erobic * Mass rates
:::Inﬁe; Model Effluent .
uen’ WAS
Influent - COD 5 " Both
Pump ¥
Sludge
5 Splitter ¥ Transpose table
Cancel |
Elements | Influent | Anoxic Aerobic | Effluent | WAS |
COD - Total [ka /d] 50,000.12 2,066,615.31 2,044,828.86 3,652.17 19,497.14
BOD - Total Carbonaceous [kg /d] 24,520.56 606,633.73 592,708.01 416.10 5,660,838
Total suspended solids [ka /d] 22,271.22 1,752,419.23 1,742,104.19 890.51 16,664.23
Volatile suspended solids [ka /d] 19,771.22 1,413,482.37 1,402,492.50 716.91 13,415.69
M - Total Kjeldahl Mitrogen [kg M/d] 4,000.30 110,671.03 107,991.14 291.45 1,027.30
M -Total M [kg M/d] 4,000.30 110,756.71 110,305.17 745.29 1,038.52
P - Soluble PO4-P [kg P/d] 325.10 1,491.33 1,544.55 302.92 7.49
P -Total P [kg P/d] 650.20 35,265.05 35,265.05 320.16 330.04
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Usability Upgrade — Optional Alarms

e As part of the project options, select which alarms are active

B Current Project Opticns X
tdadel | Unitsystem | Numerical parameters  Alarm options Drawingbuardlpipe l

Incude {chedk) f exdude (uncheck) the following alarms in this project

Flow spedifications could not be achieved

Spedified D.0O setpoint above 90% saturation value - using 90% of saturation value

Nitrogen limited conditions occurred

Phosphorus limited conditions occurred

Caldum or Magnesium limited conditions occured

More than 10%; of effluent M is stripped as ammonia

The air flow rate reguired to achieve the DO setpoint exceeds the spedfied maximum air flow rate
The desired air flow rate was adjusted to within the range specified.

The power supply required to achieve the DO setpoint exceeds the maximum power supply rate
The power supply requested exceeds the maximum power supply rate

High air flow [ diffuser

DO in tank is higher than spedfied setpoint due to DO in input (even without aeration).

Low pH inhibition for autotrophs

High pH inhibition for autotrophs

Low pH inhibition for heteratrophs

High pH inhibition for heterotrophs

Low pH in digester - may be acidic

pH (or IS) could not be calculated - low bound)

pH {or I5) could not be calculated - (high bound)

15 {or pH) could not be calculated - (high bound)

pH could not be calculated

Warning: High ionic strength (activity coefficients)

Calculated pH and specified pH are quite different from each other

Biofilm, media and liquid volume exceeds tank wvolume. Increase the assumed biofilm thickness to address this problem.
The air flow rate required to achieve the DO setpoint is below the specified minimum air flow rate
v| Consider turning on ammonia stripping model and gas phase modelling.

| Anion or Cation limitation for growth

v| Spedified DO setpoint cannot be achieved - specify a lower value

PR R T [ [ [ R R 1 [ o o R o [ [ [ [ (R [

Cancel

MANUAL REFERENCE :

General Operation > Managing BioWin Projects > Setting Project Options > Alarm
Options
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Usability Upgrade — Set All Parameters to Default

Use to upgrade older models to Version 6

Project | View Simulate Help

Farameters Seration/M ass transfer ... \
Flant L Kinetic ...
- Costz/Energy r Stoichiometnc ... -
3 Info Settlng ... _
fg} Motes Biafilm ...
Physzical/Chemical ...
Current Project Options ... T
Other ...
kadel builder ...
Set defaults ..
Iy Mew Project Options .. : e
Databaze » |
1 | —_
MANUAL REFERENCE :

General Operation > Managing BioWin Projects > Specifying Project Model
Parameter Values

23 | Usability Upgrade — Set All Parameters to Default




Specify which parameter sets to update

Er Parameters

oet parameters to defaultwalues |

Available global parameter lists

[All~ ¥ |

Selected global parameter lists

Aeration/mass transfer - Aeration
Aeration/mass transfer - Anaerobic digester
Aeration/mass transfer - Blower
Aeration/mass transfer - Diffuser
Aeration/mass transfer - Emission factors
Aeration/mass transfer - Henry's law constants
Aeration/mass transfer - Mass transfer
Aeration/mass transfer - Surface aerators
Biofim - Biofilm general

Biofilm - Effective diffusivities [m2/s]

Biofilm - EPS Strength coefficents [ ]

Set selected parameter list values to default values
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Usability Upgrade — Solution Densities

MANUAL REFERENCE :

Model Reference > Chemical Precipitation Reactions

For metal salt input streams

E  Parameter editor >
Ferates Fe congtants ] Fe RedOx rates ] CEPT rates ] Al rates Al constante ]
Properties constants Metal zalt solution densities ] Mineral precipitation rates ] Mineral precipitation constants ]
Parameters
Mote
MName Default Value | The solution densities specified are the “pure”
Ferric chloride solution density [kg/m3] 3,820.0000 [3,820.0000 | | component densities.
Ferrous chloride solution density [kg/m3] 3,160.0000 3,160,0000

They are used when you specify the metal
Aluminium sulfate solution density [ka/m3] 1,950.0000 1,950,0000 concentration in terms of % wt. fut.

BioWin assumes ideal solution behaviour for
volume, thatis:

V=EW

or that the mixture volume is equal to the
sum of volumes of its components.

Print all Set current tab to default values | QK. | Cancel ‘
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Usability Upgrade — Additional Flow Units

MANUAL REFERENCE :

General Operation > Managing BioWin Projects > Setting Project Options > Unit
SystemCubic meters per hour option for smaller systems

& Current Project Options *

bodel  Unitsystem | Numericalgarameters | Alarm options Drawingboard]Pipe ]

Flow units Motes
& m3/d The same basis is used for flow and
~ volume, i.e., if L/d are selected for
m3fhr flow units, then L are assumed for
C volume,
The flow units "gal/d" and "mgd” use
" MLd the U.5. gallon (=3.7854L)
' mgd When the flow unit basis is changed,
previously entered flows and
" galfd volumes are converted
BOD basis
¥ Sday
" 7day
i 20 day

Cancel
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Usability Upgrade — S per wet tonne sludge costs

MANUAL REFERENCE :

Operating Costs in BioWin > Operating Costs > Sludge

Third sludge disposal cost option added

B Editing WAS X
Power/Costs l Tags | Monitor items
[v Indude this sludge output in power cost calculations
Sludge options (for power fcost calculations)
[~ Sludge disposal (dry)
[~ Sludge disposal (volumetric)

v Sludge disposal {wet tonne)  [0.1000 £f(wet tonne)

™ Power

Cancel

Press F1 for help
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Usability Upgrade — More Examples

BioWin Cabinet reorganized and greatly expanded with
additional examples

# |- | o || B &

Full Plant Models [
Biclogical Mutrient R I » IFAS "
cl; Dg.lcal ) : rien lem-:n.ra ’ MER N
4 : emica dﬂerl;wa ’ MBER . -
el Trickling Filters b
Sidestream Treatment 2
1 Onidation Ditch , Other Precipitates »
xieation Liteh=s Chernically Enhanced Primary Treatment  »
GS5T » :
Miscellaneous r
SBR 3
Industrial Examples 2 e
* Clarifier Modeling b Sl e IEAS

I < Biolegical Mutrient Remowal e

il Chemical P Removal Alurn to influent channel

v B

Energy and Opkx ' Alum to aeration basin
i *

L ey T E Alum to final clarifier channel
Cridation Ditches L4 ) .

Ferric to influent channel
GSST r . . .
SER . Ferric to aeration basin
Industrial Examples » Ferric to final clarifier channel
Clarifier Modeling » Ferric Multi-point dosing

Simple Ferric addition comparison

Ferric to influent Alum to aeration basin

I ml ThI Trenbia 117 &al
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